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Abstract 
 
Water quality system  
 
Water pollution is one of the biggest threats for the green globalization. Water pollution 
affects human health by causing waterborne diseases. To prevent the water pollution, 
necessary steps are to be taken. First step is to estimate the water parameters like pH, 
turbidity, conductivity etc., as the variations in the values of these parameters point towards 
the presence of pollutants. In the present scenario, water parameters are detected by chemical 
tester laboratory test, where the testing equipment’s are stationary and samples are provided 
to testing equipment’s. Thus, it is a manual system with tedious process and is very time 
consuming. In order to minimize the time and to make the system automated, the testing 
equipment’s can be placed in the river water and detection of pollution can be made remotely. 
To ensure the safe supply of drinking water, the quality should be monitored in real time for 
that purpose Arduino based water quality monitoring has been proposed. In this report, the 
design of Arduino based water quality monitoring system that monitors the quality of water 
in real time is presented. This system consists of different sensors which measures the water 
quality parameter such as pH, conductivity, muddiness of water, temperature. The measured 
values from the sensors are processed by microcontroller and the processed values are 
transmitted using GSM to the concerned authority. 
 
INTRODUCTION 
This project includes the information concerning the research and development of a simple 
and convenient water quality measuring device. Furthermore, this document is considered 
beneficial for the development of water quality measuring devices for the measurement and 
analysis of water used for living things, for example, human beings, animals as well as 
marine fishes and plants.  
 
We consume water every day, so it is indispensable for us. Therefore, water should be 
checked now and then. Since water has a direct effect on life on earth; it has become crucial 
to check whether the water is in good condition to use. Checking the quality of water requires 
much hard work.  
 
Most of the things that exist in the earth dissolve in water, and it is very hard to determine the 
amount of the material mixed in it. For determining the number of materials in water requires 
much hard work and is time-consuming. It has become necessary with the evolving 
technology a quick and efficient method determine the quality of water. This project focuses 
on checking the pH value, turbidity and temperature, which can be verified on a daily basis. It 
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includes the description of the needed sensors and its specifications. This project includes the 
schematic, layout of the whole project idea. Every sensors Logic and layout is presented in a 
clear and sophisticated method. The circuit design for the device is also presented and 
described. It has all the necessary materials for the project to be completed in an easy and 
straightforward way. Every step about how to make the device is fully described with some 
pictures in it. It is possible to make the device either from the starting phase, or you can select 
the parts and combine it. Therefore, it has two ways to make the device.  
 
It is quite a new step in developing water quality measuring device, which will be helpful for 
the new researchers to go through the development of a new improved device for the quality 
check of water. This project focuses on the present requirement for the development of 
sanitation in water.  
 
There are many other factors which could be found in water, but these three factors like pH, 
turbidity and temperature are crucial to determine the quality. It helps to determine either 
water is basic or acidic as well as to determine the number of solid particles dissolved in 
water. As a whole, this project contributes to determining the quality of water in a convenient 
and user-friendly method for measuring the pH, turbidity and moisture.  
 
Water is most indispensable for living life, and the quality of water is the essential part we 
should take care of all the time before consuming. Because of modern technology, water is 
polluted in a different form. As a result, it is necessary to be careful about the cleanliness of 
the water. Since, living things and beings health are mostly dependent on the water, which is 
why quality check of water in every process is becoming essential, and it should be taken 
care.  
 
According to the world water quality statistics, about two millions of sewage waste from the 
agriculture, industry and homes are discharged to the water every day. This is same as the 
human population in the world. All aspects of life on Earth are permeated by Water. For 
sustaining living beings and plants, water is essential. To maintain ecosystems, water plays a 
vital role in the maintenance of human health, daily needs and for the well-being. Water helps 
us to sustain and create job opportunities in various sectors like fisheries, agriculture, 
aquaculture and many others. For producing electricity, producing foods, production of fuels 
water plays a vital role. The electricity generated using fast flowing river is the noiseless and 
pollution less method. A cycle of continuous evaporation, precipitation and runoff are the 
natural resources which maintain the renewal of fresh water in the world.  
 
Water is available everywhere on the Earth, and about 70 percent of the world’s area is 
covered with water. Most of the living thing those exist in this world largely made of water. 
The human body consists about two-thirds of water. The water is a liquid which is colourless, 
odourless and tasteless. The scientist who was an Italian, “Stanislao Cannizzarro” defined the 
chemical formula of the water molecule. Water molecular formula is H2O. Water is also 
called Universal solvent because of its ability to react with most of the substances. Even 
though pure water is not conductive for electricity, but the substances that mix up with the 
water makes it possible to conduct electricity. Water boils at 100 °C and freezes at 0 °C. 
Water volume changes with the change in temperature. When the water cools, it starts to 
contract, and the maximum density it can contract is 1 gram per cubic centimetre at 4 degree 
Celsius. If we cool it further, it expands, at the freezing point, it expands most. Water has 
more volume when it is in liquid form, which explains why the ice cube floats in the water or 
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other liquids. Even though the density property of water is of slight importance to the 
beverage example, it has considerable impact on the survival of aquatic life inhabiting a body 
of water. Waters density property has an essential importance for the survival of aquatic life.  
 
LITERATURE REVIEW  
Nikhil Kedia entitled “Water Quality Monitoring for Rural Areas-A Sensor Cloud Based 
Economical Project.” Published in 2015 1st International Conference on Next Generation 
Computing Technologies (NGCT-2015) Dehradun, India. This paper highlights theentire 
water quality monitoring methods, sensors, embedded design, and information dissipation 
procedure, role of government, network operator and villagers in ensuring proper information 
dissipation. It also explores the Sensor Cloud domain. While automatically improving the 
water quality is not feasible at this point, efficient use of technology and economic practices 
can help improve water quality and awareness among people. 
 
Jayti Bhatt,Jignesh Patoliya entitled “Real Time Water Quality Monitoring System”.This 
paper describes to ensure the safe supply of drinking water the quality should be monitored in 
real time for that purpose new approach IOT (Internet of Things) based water quality 
monitoring has been proposed. In this paper, we present the design of IOT based water 
quality monitoring system that monitor the quality of water in real time. This system consists 
some sensors which measure the water quality parameter such as pH, turbidity, conductivity, 
dissolved oxygen, temperature. The measured values from the sensors are processed by 
microcontroller and this processed values are transmitted remotely to the core controller that 
is raspberry pi using Zigbee protocol. Finally, sensors data can view on internet browser 
application using cloud computing. 
 
Michal Lom, Ondrej Pribyl, Miroslav Svitek entitled “Industry 4.0 as a Part of Smart Cities”. 
This paper describes the conjunction of the Smart City Initiative and the concept of Industry 
4.0. The term smart city has been a phenomenon of the last years, which is very inflected 
especially since 2008 when the world was hit by the financial crisis. The main reasons for the 
emergence of the Smart City Initiative are to create a sustainable model for cities and 
preserve quality of life of their citizens. The topic of the smart city cannot be seen only as a 
technical discipline, but different economic, humanitarian or legal aspects must be involved 
as well. In the concept of Industry 4.0, the Internet of Things (IoT) shall be used for the 
development of so–called smart products. Subcomponents of the product are equipped with 
their own intelligence. Added intelligence is used both during the manufacturing of a product 
as well as during subsequent handling, up to continuous monitoring of the product lifecycle 
(smart processes). Other important aspects of the Industry 4.0 are Internet of Services (IoS), 
which includes especially intelligent transport and logistics (smart mobility, smart logistics), 
as well as Internet of Energy (IoE), which determines how the natural resources are used in 
proper way (electricity, water, oil, etc.). IoT, IoS, IoP and IoE can be considered as an 
element that can create a connection of the Smart City Initiative and Industry 4.0 – Industry 
4.0 can be seen as a part of smart cities. 
 
Zhanwei Sun,Chi Harold Li,Chatschik Bisdikian,Joel W.Branch and Bo Yang entitled “QOI-
Aware Energy Management in Internet-of-Things Sensory Environments”. In this paper an 
efficient energy management frame work to provide satisfactory QOI experience in IOT 
sensory environments is studied. Contrary to past efforts, it is transparent and compatible to 
lower protocols in use, and preserving energy-efficiency in the long run without sacrificing 
any attained QOI levels. Specifically, the new concept of QOI-aware “sensor-to-task 
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relevancy” to explicitly consider the sensing capabilities offered by an sensor to the IOT 
sensory environments, and QOI requirements required by a task. A novel concept of the 
“critical covering set” of any given task in selecting the sensors to service a task over time. 
Energy management decision is made dynamically at runtime, as the optimum for long-term 
traffic statistics under the constraint of the service delay. Finally, an extensive case study 
based on utilizing the sensor networks to perform water level monitoring is given to 
demonstrate the ideas and algorithms proposed in this paper, and a simulation is made to 
show the performance of the proposed algorithms. 
 
Sokratis Kartakis, Weiren Yu, Reza Akhavan, and Julie A. McCann entitled “Adaptive Edge 
Analytics for Distributed Networked Control of Water Systems” This paper presents the burst 
detection and localization scheme that combines lightweight compression and anomaly 
detection with graph topology analytics for water distribution networks. We show that our 
approach not only significantly reduces the amount of communications between sensor 
devices and the back end servers, but also can effectively localize water burst events by using 
the difference in the arrival times of the vibration variations detected at sensor locations. Our 
results can save up to 90% communications compared with traditional periodical reporting 
situations. 
 
Current Situation  
Water quality is our goal, we have to consider different types of thing that pollute the water, 
and when we check the quality of water, there are the most important factors we can depend 
on to check it. Water quality measuring device is important in medicine, biology, agriculture, 
forestry, food science, environmental science, oceanography, Civil engineering, chemical 
engineering, nutrition, water treatment and water purification, and many other applications. 
The pollution in water is increasing day by day, and many researchers and scientists are 
trying to solve the problem by checking and maintaining the quality of water. This project 
focuses mainly on the quality check of water.  
 
The aim of the project is to test the water quality artificially so that it will be possible to keep 
human life safe from the polluted water. Analysing the condition and checking whether the 
water is favourable for the living beings and plants is the main target. There are different 
kinds of the available water quality measuring device on the market, ranging from cheap to 
expensive ones and house to industrial applications. Devices are very costly and hard to 
understand for the consumer and might be affordable but cannot fulfil the needs of quality 
checking ineffective and fast ways.                                                
 
Block Diagram 
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FIRMWARE IMPLEMENTATION OF THE PROJECT DESIGN 

 

FIRMWARE IMPLEMENTATION  

This chapter briefly explains about the firmware implementation of the project. The required 

software tools are discussed in the following sections.  

 

Software Tool Required 

Arduino 1.0.6 software tools used to program microcontroller. The working of software tool 

is explained below in detail. 

 

PROGRAMMING MICROCONTROLLER  
A compiler for a high level language helps to reduce production time. To program the 

Arduino UNO microcontroller the Arduino is used. The programming is done strictly in the 
embedded C language. Arduino is a suite of executable, open source software development 
tools for the microcontrollers hosted on the Windows platform. 

 
Arduino is a tool for making computers that can sense and control more of the physical 

world than your desktop computer. It's an open-source physical computing platform based on 
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a simple microcontroller board, and a development environment for writing software for the 
board. 

 
One of the difficulties of programming microcontrollers is the limited amount of resources 

the programmer has to deal with. In personal computers resources such as RAM and 
processing speed are basically limitless when compared to microcontrollers. In contrast, the 
code on microcontrollers should be as low on resources as possible 
 
ABOUT ARDUINO COMPILER 
GET AN ARDUINO BOARD AND USB CABLE 
You also need a standard USB cable (A plug to B plug): the kind you would connect to a 
USB printer, for example. (For the Arduino Nano, you'll need an A to Mini-B cable instead.) 

                                                     

 
 
CONNECT THE BOARD 
The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power from 
either the USB connection to the computer or an external power supply. If you're using an 
Arduino Diecimila, you'll need to make sure that the board is configured to draw power from 
the USB connection. The power source is selected with a jumper, a small piece of plastic that 
fits onto two of the three pins between the USB and power jacks. Check that it's on the two 
pins closest to the USB port. Connect the Arduino board to your computer using the USB 
cable. The green power LED (labelled PWR) should go on. 
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Open the blink example 
Open the LED blink example sketch: File > Examples > 1.Basics > Blink. 
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Select your board 
You'll need to select the entry in the Tools > Board menu that corresponds to your Arduino. 
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WRITING SKETCHES 
Software written using Arduino are called sketches. These sketches are written in the text 
editor. Sketches are saved with the file extension .ino. It has features for cutting/pasting and 
for searching/replacing text. The message area gives feedback while saving and exporting 
and also displays errors. The console displays text output by the Arduino environment 
including complete error messages and other information. The bottom righthand corner of the 
window displays the current board and serial port. The toolbar buttons allow you to verify 
and upload programs, create, open, and save sketches and open the serial monitor. 
 
NB: Versions of the IDE prior to 1.0 saved sketches with the extension .pde. It is possible to 
open these files with version 1.0, you will be prompted to save the sketch with the .ino 
extension on save. 

Additional commands are found within the five menus: File, Edit, Sketch, Tools, Help. The 
menus are context sensitive which means only those items relevant to the work currently 
being carried out are available. 
 
SELECT YOUR SERIAL PORT 
 
Select the serial device of the Arduino board from the Tools | Serial Port menu. This is likely 
to be COM3 or higher (COM1and COM2 are usually reserved for hardware serial ports). To 
find out, you can disconnect your Arduino board and re-open the menu; the entry that 
disappears should be the Arduino board. Reconnect the board and select that serial port. 
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UPLOAD THE PROGRAM 
Before uploading your sketch, you need to select the correct items from the Tools > 
Board and Tools > Serial Port menus. The boards are described below. On the Mac, the 
serial port is probably something like /dev/tty.usbmodem241 On Windows, it's 
probably COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a 
USB board) - to find out, you look for USB serial device in the port section of the Windows 
Device Manager. On Linux, it should be /dev/ttyUSB0,/dev/ttyUSB1 or similar. 
 
Once you've selected the correct serial port and board, press the upload button in the toolbar 
or select the Upload item from the File menu. Current Arduino boards will reset 
automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, 
you'll need to press the reset button on the board just before starting the upload. On most 
boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino 
environment will display a message when the upload is complete, or show an error. 
 
When you upload a sketch, you're using the Arduino bootloader, a small program that has 
been loaded on to the microcontroller on your board. It allows you to upload code without 
using any additional hardware. The bootloader is active for a few seconds when the board 
resets; then it starts whichever sketch was most recently uploaded to the microcontroller. The 
bootloader will blink the on-board (pin 13) LED when it starts (i.e. when the board resets). 
 
Now, simply click the "Upload" button in the environment. Wait a few seconds - you should 
see the RX and TX leds on the board flashing. If the upload is successful, the message "Done 
uploading." will appear in the status bar. (Note: If you have an Arduino Mini, NG, or other 
board, you'll need to physically present the reset button on the board immediately before 
pressing the upload button.) 
 

 
A few seconds after the upload finishes, you should see the pin 13 (L) LED on the board start 
to blink (in orange). If it does, congratulations! You've gotten Arduino up-and-running. 
 

RESULTS AND DISCUSSIONS 
 
WORKING PROCEDURE 
Water quality measurement has become an essential task nowadays as the pollution, human 
waste is increasing at an alarming rate day by day and all these wastes are mixing with water 
finally. 
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This project demonstrates to know the quality of water by measuring the turbidity, moisture 
and pH value. The system uses the sensors like turbidity sensor, moisture and pH sensors to 
determine the quality of water. LCD is used to display the sensor values and also these values 
are uploaded to the web page using Wi-Fi module. 
 
Turbidity has indicated the degree at which the water loses its transparency. It is considered 
as a good measure of the quality of water. Turbidity blocks out the light needed by 
submerged aquatic vegetation. It also can raise surface water temperatures above normal 
because suspended particles near the surface facilitate the absorption of heat from sunlight. 
 
The pH of a solution is the measure of the acidity or alkalinity of that solution. The pH scale 
is a logarithmic scale whose range is from 0-14 with a neutral point being 7. Values above 7 
indicate a basic or alkaline solution and values below 7 would indicate an acidic solution. It 
operates on 5V power supply and it is easy to interface with arduino. The normal range of pH 
is 6 to 8.5. 
 
Arduino accesses the sensor values and processes them to transfer the data through internet. 
The sensor data can be viewed on the internet wi-fi system. 
 
BLYNK app is installed in the android version to see the output. When the system gets 
started, the parameters of water are tested and the result is displayed on the LCD display. The 
app provided with hotspot gives the exact value as on LCD display shows on kit. Thus when 
the kit is located on any specific water body and WIFI provided, we can observe its real time 
value on our android phone anywhere at any time. 
 
Conclusion 
The system proposed in this paper is an efficient, inexpensive IoT solution for real-time water 
quality monitoring. The developed system having Arduino Mega and NodeMCU target 
boards are interfaced with several sensors successfully. An efficient algorithm is developed in 
realtime, to track water quality. The measured pH value ranges from 6.5 to 7.5 and 7 to 8.5 
for groundwater. The measured value of turbidity ranges from 600 to 2000 NTU for both 
Hyderabad Metropolitan city supply water and groundwater. A web-based application i.e., 
ThingSpeak is used to monitor the parameters such as pH value, the turbidity of the water, 
level of water in the tank, temperature and humidity of the surrounding atmosphere through 
the webserver. Further, these measured parameters also monitored in Thing Speak mobile 
application. Also, this work needs to be carried out to analyse several other parameters like 
electrical conductivity, free residual chlorine, nitrates, and dissolved oxygen in the water. 
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